Making Accessible MS Word Documents

When creating a MS Word document, it does not require a lot of extra effort to make the document
accessible to people with disabilities. This article gives instructions on a few key things that will make
documents much more accessible to people with disabilities using assistive software.

For additional ways to make Word documents more accessible, please view the article published by
Microsoft on Creating Accessible Word Documents.

Accessibility Checker

The Microsoft Office products have a built in accessibility checker that will check the document for
elements that are considered inaccessible. Elements that are found to be inaccessible will be flagged
and a description of the problem will be provided along with steps for fixing the problem. The Microsoft
article for the accessibility checker can be viewed here: Microsoft Accessibility Checker.

Open Accessibility Checker
The Accessibility Checker can be opened by doing the following steps:

1. Click on the File tab
2. Click on the button labeled Check for Issues
3. Click on Check Accessibility in the drop down

@ Inspect Document
s Before publishing this file, be aware that it contains:

Check for Document properties and author's name

Issues ~ e s
Content that people with disabilities are unable to read

|1~\ Inspect Document
=" Check the document for hidden properties

or personal information.

D Check Accessibility
@ Check the document for content that people
with disabilities might find difficult to read.

@ Check Compatibility
Check for features not supported by earlier

versions of Word.

d changes.

How to Use the Accessibility Checker

The Accessibility Checker has two parts. The top part is Inspection Results, which lists all of the
accessibility errors and warnings contained within the document. Errors are items that make the
document unreadable or very difficult to navigate for someone using assistive technology.
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https://support.office.com/en-us/article/Creating-accessible-Word-documents-d9bf3683-87ac-47ea-b91a-78dcacb3c66d%23__toc275414987
https://support.office.com/en-us/article/Check-for-accessibility-issues-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f?ui=en-US&rs=en-US&ad=US

Warnings are style and formatting choices within the document that can make the document difficult to

read or navigate for a user with disabilities. Warnings are less severe than errors but should still be
corrected if possible.

Accessibility Checker r X

Inspection Results

"? Errors

= Missing Ak Text
Picture 1

Additional Information w

Why Fix:

Alternate text helps readers
understand information
presented in pictures and
other objects,

| »

|How To Fix:

To add alternate text o a
picture ar object

1] Right-click an the object
ahd select the Format
command.

2] Switch to the Alt Text tab.
3] Type a description of the ;I

In the example pictured above, a picture without Alt Text is flagged as an error. Without the Alt Text
any user that is unable to see the image would not know what it contains. Double clicking on the item
identified (Picture 1 in the screen shot) will move the document to that location.

The bottom part to the Accessibility Checker provides additional information on why the particular error

or warning is an issue, and steps to fix it. Once the steps are followed and the error is resolved, it will
disappear from the list automatically.

Add Accessibility Checker to the Ribbon
The Accessibility Checker can be added to the Ribbon by doing the following steps:

1. Click on the File tab
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2. Click on Options

W I
1 Home Accessibility

[l save
Save A

o Save as &dobe PDF
Lj Qpen
d Close

Recent

Mew

Print

Save & Send

Help

] Options |2

3 Exit

3. Click on Customize Ribbon
4. Inthe Customize the Ribbon drop down (on the right side of the dialog), select Main Tabs
5. Find and click on the Home tab in the list of tabs on the right
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6. Click on the button New Tab

Word Options
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Language
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Breaks 4
Bullets 3
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Change List Lewe| 3
Copy

Cut

Define Mew Mumber Farmat..,
Delete
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Find

Font
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Font Calar 4
Fant Size
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Grow Font
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Insert Footnate
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Macras
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Main Tabs

Clipboard
Font

Paragraph
Styles
Editing

¥ Insert

¥ Page Layout

¥ References

¥ Mailings

[+ Review
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[~ Developer
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W Acrobat
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v Cutlining

¥ Background Removal
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Customizations: Reset = | i
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7. Right click on the newly created New Tab and rename it to “Accessibility”, do the same for New

Group

||
e |

Customize the Ribbon: '

IMain Tahs ;I

[Main Tabs
=l ¥ Hame

Clipbioard
Font
Paragraph
Shyles
Editing

=l W Mews Tab [Custom)
Mew Group [Custom Scdd Mews Tab

v Insert Add Mew Group

¥ Page Layout
[¥ References Rename

¥ tdailings J  ShowTab
¥ Review -
W i

F [T Developer Mawe Lip
¥ add-Ins
¥ &crabat

Bermowve

hAove Dowen

¥ Elog Post

8. Click on the Accessibility group.

9. Inthe Choose commands from drop down, select Commands not in the ribbon
10. Click on Accessibility Checker from the command list
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11. Click on the Add>> button to add the Accessibility checker to the Accessibility group of the

Accessibility tab
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Save
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11

| Add ==

== Remowe

Custamize the Ribbaon:(

|Main Tabs

Main Tabs
= W Home
Clipboard
Fant
Paragraph
Shyles
Editing
= W fccessibility [Custom)

|&ccessibility (Custom)

[+ Insert

¥ Page Layout

¥ References

¥ Mailings

¥ Rewiew

¥ Wiew

[~ Developer

v &dd-Ins

¥ Acrobat

¥ Blog Post

[ Insert [Blog Paost]
¥ Cutlining

¥ Background Removal

Mews Tak | ﬂewGroupl

Rename... |

Customizations: Reset = | i

ImporyExpart '| i

Making Accessible MS Word Documents

March 25, 2016

Page 6 of 12




12. Click OK

Customize the Ribborn: '

IMain Tabs LI

[Main Tabs
= W Home

Cliphaoard
Font
Paragraph
Shyles
Editing
¥ Accessibility [Custam)
[E Accessibility [Custom]
Accessibility Checker |

|

Insert
Page Layout
References

Mailings

Rlewviews

i ey

Developer

Add-Ins

Acrobat

Elog Post

Insert [Elog Past)
Qutlining
Background Removal

[

EEEEEEEEEEEEE
AR TRRRRAA]

M ews Tab | ﬂewGrDupl Rename... |

Customizations: Reset = | i

ImporyExport = | i

12 Cancel |

/)

13. Go to the new Accessibility Tab and click on the “Check Accessibility” button. This will open a

sidebar that will list out any potential issues with accessibility.

™ e AN
Horne Accessibility
®

Check
Accessibility

Accessibility
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Alternative Text (Alt Text)

Alt Text is a text description given to an image or graphic to allow people with visual disabilities to

understand what image is about. When assistive technology comes across an image it will speak any Alt

Text to the user. If there is no Alt Text for an image the assistive technology will attempt to read any

information that is available, such as the image file name, or skip it completely.

In the Microsoft Office products there are two components to Alt Text: Title and Description. The Title is

typically only a few words naming the image and is not required to be used. The Description is required

and is a brief description of the image.

To make Alt Text understandable to the user and to work best with a variety of accessibility software,

follow these guidelines in when writing Alt Text descriptions:

1. Keep the image context in mind. Avoid duplicating information already presented in the text.

Be as succinct as possible, use 125 characters or less. Longer alt text is allowed but shorter alt

text is easier to understand.

3. Acronyms should be written with a space between the letters. For example, the Alt Text “HSU

Library” could be vocalized as “Sue Library.” Putting a space between acronym letters, “H S U

Library,” will force the letters to be vocalized.

Descriptors such as “Image of” or “Picture of” are generally unnecessary and should be left off.

5. IfaTitleis used, it should be very brief: only a few words at most.

If the image performs an action, such as linking to an outside document or web page, that

should be mentioned in the description.

Adding Alt Text: MS Word 2010
1. Right Click on the image object
2. Inthe popup menu, left click on Format Picture

L
ESY
ke

cut

copy

Paste Oplions:

o %A

Sawe as Picture..,

Change Picture,.,

Hyperlink..,

Insert Captian...
Wirap Text

Size and Position..,

Format Picture..,
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3. The Format Picture dialog box will open. Click on Alt Text, and enter a description (entering a

title is optional).

Fill

Lire: Color
Line Style
Shadow

Reflection

3-D Farmat

3-D Ratation
Picture Corrections
Picture Colar
firkistic EFfects
Crap

Texk Box

Alt Tesxt

Glow and Soft Edges

At Text

Title:
ILibrar';.r'|
Descripkion:
H 5 U Library

Titles and descriptions provide alternative, text-based
representations of the information contained in tables, diagrams,
images, and other objecks, This infarmation is useful far people
with wision or cognitive impairments who may not be able to see or
understand the object,

& kitle can be read ko a person with a disability and is used to

determing whether they wish to hear the description of the
content.

Close

Adding Alt Text: MS Word 2013 and 2016

1.
2.

Right Click on the image object
In the popup menu, left click on Format Picture

& Cut
Ba Copy
Paste Options:

Save as Picture...

E‘g Change Picture...

Hyperlink...

Insert Caption...

| & @

5

:  Wrap Text

vt |

Format Picture...

Size and Position...
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3. The Format Picture panel will open. Click on the Layout & Properties icon (third from the left,
under the Format Picture text)

4. Click on Alt Text and enter a description (entering a title is optional).

5. The Format Picture pan can be left open, allowing you to click on other images and easily add Alt
Text to more images.

Format Picture N o
ISR -
I Text Box
4 Alt Text
Title i
Library
Description
H 5 U Librany

Use Built in Styles

The built in MS Word styles are very useful to many different people. To an author, styles represent a
way to change and control the formatting of entire sections or the entire documents with minimal
effort. To a sighted reader, styles are a way to visually organize a document for easier reading.

For readers with disabilities, styles also help with navigation but in a different way. Headers of various
levels (such as Header 1, Header 2, etc.) are used by assistive technology for navigation. The assistive
technology is able to read through the document and pick out the header styles, present them to the
user in an accessible format (such as audio), and provide a means for the user to navigate directly to a
desired section. If an author manually creates headers by directly changing the font size and formatting
of each header instead of using built in styles, the ability to use assistive technology to easily navigate a
document’s header sections is lost.

Haome Accessibility Insert Page Layout References Mailings Review Wiew Add-Ins Acrobat
T ] . . - - - hd - 1 g %: v 3 X
B Colibri Body) = 11 7 AT A7 | Aav | 5 =7 5= S 23BbCeDe | aaBbceDe AaBbCi AaBbCc | %
Paste B 7 U ~abe X, X° -8 A % =E=EE THormal | TMo Spaci.. Heading 1 Heading 2 | — f-hange
- 7 - T Wtyles -
Clipboard Font Paragraph Styles
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Styles are found on the Home Ribbon in the section named Styles. Making use of the built in styles is all
that is needed to make a document more accessible. Use the built in style Normal for body text and
Heading 1 for section titles. Doing just this will make a document more navigable by students using
assistive technology.

Tables

Tables are often used to organize data or information into an easy to read format. For a sighted reader,
all that needs to happen is the table information lines up in the correct rows and columns, with a header
to inform the reader about what each column and row means. But for a visually impaired reader relying
on a screen reader, a table can be a nightmare of jumbled information if it’s not setup properly.

For tables, having a designated header row with column titles is essential. Having Alt Text is also helpful
because it will describe what the table is about. Do the following to make tables accessible:

1. Inthe table, select the rows to be used as the header rows and right click on them (if it’s only
going to be the first row, just right click somewhere on the first row)
2. Leftclick on table properties

Calibri (Body] = 11+ A" A7
& B IEWY-A-b
Sales-Projections- 20164 -

01-5alesa 02-5aleso 03-5aless 04-5aless
BooksH 55,000: 56,0006 55,7500 56,5005
IWusic CDsE 52,7008 52,9004 52,4005 53,0005
E-Readersd 53,0004 52,0006 51,8005 57,0005

L =

Insert

h
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=3

Copy
Paste Options:

i e

Delete Rows
Select

Merge Cells

Ok

Eorders and Shading...

_
f—
E»

Text Direction...
Cell Alignment
AutoFit

g Tahle Properties...

3. Click on the Row tab, ensure that the rows identified are the ones you want to become the
header row.
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4. Check the box marker “Repeat as header row at the top of each page”

Tahle Raow |Cnlgmn I Cell | Alt Textl

Rows 1-2:
Size
[ specify height: m Row height is: I.C\t least vl
Qptions

v Allovs row bo break across pages

peat as header row at the top of each page:

& Previous Row ¥ Mext Row

QK I Cancel |

Click on the Alt Text tab and fill in the Title and Description boxes for the table

Click OK
Tahle | R ICDIgmnl Cell alk Textl
Title

ISaIes Projections 2016

Description

Table of quarterly projected book store sales,

Alternative Text

web browsers display alternative text while kables are loading or if they are
missing. M'eb search engines use the alternative text to help find Web pages.
Alternative Text is also used to assist disabilities,

QK I Cancel
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